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Preferences
The Preferences is the place where you can tweak several settings to your needs. It
can be opened in the Edit menu in the top bar.

The Preferences contains several tabs. And every tab contains several rows or
panels with content. We will go through them one by one.

When you have changed something, and want that changes to be permanent, then
you are required to save the user settings. See the Save User Settings button in the
header.

Navigation Sidebar
At the left side you will find the navigation elements to
access the different categories. At the bottom resides the
Save Preferences menu.

Save Preferences menu

Auto Save preferences

Changes at the preferences are saved automatically when
Auto Save Preferences is ticked.  When this option is off,
then changes needs to be saved manually. When you don't
save the changes, then Bforartists loads the next time with
the status before the changes.

Save current State

Manually saves the current state.

Revert to Saved

This option is just available when Auto Save preferences is off. It reverts the settings to the last saved state.

Load Factory Settings

Resets the settings to the factory defaults.

Note

Not everything can be changed from the Preferences. Everything regarding layout is
stored in the Startup File, and not in the Preferences. So when you want to save a
layout change then you have to save the startup file. The menu item is right above
the Preferences button in the Edit menu.
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Interface Tab
The Interface category contains settings to change how
UI elements are displayed and how they react. 

Display Panel

Resolution Scale

At 4K displays the whole UI elements are usually
ways too small. Scale the whole UI size display by
moving the slider to the needed value. 

Line Width

Define the size of the line between the editors. This is a theming setting.

Viewport Line Width

Changes the appearance of only lines in the 3D Viewport.

Splash Screen

Display the Splash Screen when starting Bforartists.
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Tool tips

Display tool tips in the UI. With this feature unticked you won't see any tool tips anymore. It is not 
recommended to turn this feature off. The icon buttons needs the tool tips to display the tool name.

Python Tool tips

Every tool tip can also display the Python code tag for the tool. It may look
like noise in the first moment. But can give you some further hints here and
there. Some tool tips, like the Node editor buttons, doesn't have a proper
tool description by design. Here the Python tool tip can tell you the
function when you turn it into pure icon buttons.

The tools in the tool shelf doesn't have a Python tool tip by design. This buttons sits on top of
the normal operators, and doesn't access the tool tip of it.

Note: It is not recommended to turn the Python tool tips off.

Developer Extras

This tick box turns on or off the developer entries in the right click
menus.

Sort Search by Most Recent

This affects all search fields in Bforartists. Sort the recently searched items at the top.

Editors Panel

Region Overlap 

This checkbox will enable Blender to draw the Header, Tool Shelf and the
Sidebar overlapping the 3D View. The transparent areas becomes workspace
area. You can for example select vertices now in the transparent areas.

If you have a capable graphics card and drivers with Triple Buffer support,
clicking the checkbox will enable the overlapping regions to be drawn using the 
Triple Buffer method, which will also enable them to be drawn using Alpha,
showing the 3D View contents trough the Object Tools and Transform Properties regions.

Color Picker Type

Choose the type of Color picker that will show when
you click on a color field. You can choose between
three square types and two circle types.
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Header Position

Define at which default position the headers of the editors should reside.

Factor Display Type

Display factor values either as percentage or as factor.

Temporary Editors subpanel

How the temporary editors behave.

Render in 

Where to display the rendered image.

File browser

Where to open the file browser.

Status Bar subpanel

What content to display in the status bar at the bottom. 

Translation Panel
Choose another default language for Bforartists.

Language

Choose between automatic language detection. In this case the
system language gets chosen. Or pick a language that you want to
use.

Tool tips

Tool tips translates the tool tips too.

Interface

Interface translates all the interface texts
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New Data

New data is meant to edit the localization texts. 

This can be done in the right click menus of the tools when
everything is set up in the correct way.

This is a development feature. You need a repository of
Bforartists!

Note

This feature is currently not functional in Bforartists. It ends in an error message.

Let's nevertheless document the way how it should work. Note that you need a Bforartists repository for that. 
The binary version does not come with the editable *.po files, but with already compiled *.mo files for the 
translation.

Note that you first need to set the path to the translation
files for that. Or you will get an error. This is done in
the File tab. The |18n string.

The path should lead to the *.po files that you want
to translate. Which can be found in the Bforartists
repository.

And you need to enable the Manage UI translations add-on. And to fix the paths in this add-on. The default 
paths are currently set for Blender.

And then you might end in this error here ...

In case somebody has an idea what's going on here, every hint is welcome ...
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Text Rendering Panel
Text related settings for the font of the interface.

Anti Aliasing

Use Anti Alias at the UI elements to prevent pixelated look of the font. 

Hinting

What sharpening method to use to make the text render sharp.

Interface Font
Define a custom interface font. The font in the whole UI.

Monospace Font
Define a custom Monospace font. That's the one used in the python console for example.

Menus Panel

Open on Mouse Over

Normally you click at a menu to open it. With Open on
Mouse Over the menu opens up when you just hover with
the mouse over it.

Top Level

Adjust the time delay before the top level menu opens on mouse over.

Sub Level

Adjust the time delay before a sub level menu opens on mouse over.

Pie Menus
Bforartists has some pie menus that can be called by hotkeys. Here you find some settings for it.

Animation Timeout

The pie menu fades in with an animation. Adjust the time needed to fully unfold the pie menu.

Top Key Timeout

Pie menu button longer held than this time will dismiss the menu on release.

Recenter Timeout

Pie menus will use the initial mouse position as center for this amount of time. The value is in 1/100 seconds.
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Radius

The pie menu size in pixels.

Threshold

The distance that is needed from the center to move the mouse so that a selection can be made.

Confirm Threshold

Distance threshold after which selection is made. A value of zero disables this feature.

Themes
The Themes tab allows you to customize interface
appearance and colors. There are various elements that
can be themed. 

Any change here will appear in real-time on your screen
in the corresponding editor. 

To change a color for a UI element, simply click at one of
the color fields. A color dialog will open up to choose a
new color.

Presets
Bforartists comes with several theme presets. You can choose between them in
the drop down box. Don't forget to save the user settings to make the change to
the new preset permanent.

Create new Theme

To create a new theme, click the + button next to the preset selection drop-down and enter a name. This will 

save the theme to an XML file in the ./scripts/presets/interface_theme/ sub directory of one of

the configuration directories.
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To share the new created theme you have to copy it from that folder. This
XML file can then be loaded as a theme at another computer with Bforartists
installed.

 

Install
Install an external theme. This button will open a file browser.

Reset
Resets all made changes, and resets the current theme to its initial state.

List of Editors
The list of the editors that you can theme. Every editor can have its own theming.

Viewport
Contains the settings for the 3D Viewport. 

Display

Text Info Overlay

Object Info

Display current frame, collection name and Object name in the upper left edge of the 3D
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view.

The letters appears in yellow when the current frame of the selected object has a keyframe.

View Name

Display the name of the current view up left in the 3D view.

Playback Frame Rate (FPS)

Show the frames per second screen refresh rate while an animation is played back. It appears
in the viewport corner, displaying red if the frame rate set cannot be reached. And replaces the
View name while the animation is playing.

Frame Rate Samples

The number of frames to use for calculating the fps average. A value of zero calculates the fps automatically, 
where the nunber of samples matches the target fps.

Gizmo Size

Adjust the size of the transform gizmo that appears when you have one of the transform tools
activated.

HDR Preview size

How big the preview spheres are displayed.

3D Viewport Axis

Adjust the apperance of the 3D Viewport mini axis widget.

Off

Hides the Mini axis widget

Simple Axis

Shows simple axis. This widget type is not interactive. It just shows the state of the viewport rotation.

Size

The size of the simple mini axis widget.

Brightness

The brighness of th simple mini axis widget.

Interactive Navigation

The default mini axis widget. This widget is interactive. Clicking and
dragging will rotate the viewport. Clicking at one of the colored spots at
the end of the axis will snap to the neares orthographic view.

Size

The size of the interactive navigation widget.
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Fresnel in Edit Mode

Enable a fresnel effect on edit mesh overlays. This feature improves shape readability of very dense meshes. 
But can increase eye fatigue when modeling lower poly.

Quality
Contains the settings to adjust the display quality in the
viewport.

Viewport Anti-Aliasing

The anti alias quality settings for the solid mode rendering in the 3d viewport.

Multi sampling

Set the OpenGL Multi sampling in case your system supports it.

Grease Pencil Multi sampling

The grease pencil drawing has its own OpenGL Multi sampling. Set the OpenGL Multi
sampling in case your system supports it.

Edit Mode Smooth Wires

Enable Edit Mode edge smoothing which reduces anti alias and makes the edge more sharp. A change requires 
a restart of the software.

Textures

Limit Size 

Limit the maximum resolution for pictures used in textured display to save memory. The limit
options are specified in a square of pixels, (e.g.: the option 256 means a texture of 256×256
pixels) This is useful for game engineers, whereas the texture limit matches paging blocks of
the textures in the target graphic card memory. Available Options are: Off (No limit), 128, 
256, 512, 1024, 2048, 4096, and 8192. 

Anisotropic Filtering 

Sets the level of anisotropic filtering. This improves the quality of how textures are drawn at
the cost of performance. Available Options are: Off (No Filtering), 2x, 4x, 8x, and 16x. 
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Clip Alpha

Clip alpha when the value is below the here defined value.

Image Display Method

The method that is used to draw textures in the viewport.

Selection
OpenGL Depth picking tries to pick the object in front.
Without this method you may pick an object underneath.

Lights
The viewport uses different light setups in different
situations. You can switch between them in the shading
drop down in the 3d view up right.

This tab allows you to customize these light setups. And
install custom light setups.

Studio Lights
The 3D view uses Solid OpenGL lamps to light the 3D view. You can
enable four different light sources here.  These lamps does not affect the
rendering. Their only purpose is to light the 3D view.

You can turn on or off the lamps. But there should be at least one light
enabled.

Install

Install an external studio light.
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Preview Window

This window appears when you have a studio light
saved, or a new studio light installed.

Down left you can see the name of the saved library.
mystudio.sl .

This window gives you a preview of how this studio
light looks like in the 3D view then.

Up right you can find two buttons. 

Delete Studio Light

Deletes the studio light.

Copy Studio Light settings to the Studio Light Editor

The editor settings does not update immediately. It shows the default studio light setting. So when you want to 
edit the studio light, then you want to press this button to update the editor values first.

Edit Studio Light

Enable the editing of the studio light setup.

Save as Studio Light

Save the current light setup as a studio light setup. Note that this does not export the light, but saves its settings 
internally in the appdata directory.

Use Light

Turn on or off this specific light.

Diffuse

Diffuse color is the constant color of the lamp.

Specular

Specular is the highlight color of the lamp.

Smooth

Smooth the lighting from this specific light.

Direction

Adjust the direction. Click into the field and drag the sphere around until you have your desired light setup.
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MatCaps
Matcaps is a special material that can be assigned quickly to
preview geometry. Usually matcaps are used while sculpting. You
can switch between them in the shading drop down in the 3d view
up right.

Install and manage custom matcaps.

LookDevHDRI's
You can light the scene with an environment image instead of lights.
This is done with hdri images.

The viewport can do this in realtime when the shading is set to
Viewport Shading.

Install and manage custom LookDev HDRI's. Basically every image
could do the trick here. But the hdri's uses a special spherical
mapping. So you better use hdri images for this purpose.

Editing

Contains the settings around editing. Objects,
Data, etc.
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Objects

New Objects

Link Materials To

Define how materials will be linked to its objects. Almost everything in Bforartists is
organized in a hierarchy of data-blocks. A data-block can be thought of as containers for
certain pieces of information. For example, the Object data-block contains information
about the Object’s location while the Object Data ObData data-block contains

information about the mesh.

ObData 

Any created material will be created as part of the ObData data-block.

Object 

Any created material will be created as part of the Object data-block. 

Align To 

World 

New objects align with world coordinates. 

View 

New object align with view coordinates. 

Enter Edit Mode

If selected, Edit Mode is automatically activated when you create a new object. 

Instance Empty Size

Increase or decrease the size of collection empties. 

Duplicate Data

When you duplicate data, then most or all its
subpart gets duplicated too. Define which
supports should be duplicated when you
duplicate an object.
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3D Cursor

Cursor Surface Project

Use the surface depth to place the 3D cursor. That way you can place the 3D cursor at the surface of an object.

Cursor Lock Adjust

Place the cursor without a jumping effect at the new location when lock to cursor is used.

Annotations

Default Color

The default color for the annotations pencil.

Eraser radius

The eraser radius.

Weight Paint

Use Custom Colors

Bforartists uses by default a gradient that goes from red to green to
blue to black to display the different weight at a mesh.

Setup a custom gradient for the colors of a weight paint.

The + Button adds a color stop point, which can be moved around.
That way you can have more than one color in the gradient.

The - Button removes the currently selected color stop point.
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Tools Menu 

Flip Color ramp flips the color ramp.

Distribute Stops from Left distributes the color stops from the left. The position at the
right will remain empty.

Distribute Stops evenly distributes the color stops evenly across the gradient.

Eyedropper allows you to pick a color from the gradient.

Reset color ramp resets the color ramp to the default state.

Color Mode is a drop down box to choose the color mode for the gradient.

Interpolation is a drop down box to choose the interpolation mode for the gradient. 

In the Color Ramp element you will see the color ramp with the
single color stops.

Choose Active Color Stop is the stop point of the gradient.

Position is an edit box where you can numerically fine tune the position of the currently
selected color stop.

Color Ramp Element displays the color of the current selected color stop. When you click at it then you can 
open a color picker to change the color of the current color stop.

Background Color

Background color is the same color than the secondary color from the color picker. When you click at it then 
you can open a color picker to change the secondary color.

Gradient Stroke Mode

Set the gradient stroke mode.
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Grease Pencil

Manhattan Distance 

The minimum number of pixels the mouse has to move horizontally or vertically before the movement is 
recorded. 

Euclidean Distance 

The minimum distance that mouse has to travel before movement is recorded. 

Text

Auto-close Character Pairs

Automatically close relevant character pairs when typing in the text editor.

Node Editor

Auto Offset

Use Auto Offset.

Auto Offset Margin

Minimum distance in the node editor between nodes for auto
offsetting.

When you insert a new node between two existing connected nodes,
then the two nodes gets pushed to left and right, with an offset.
Adjust this offset.

Preview Resolution

Resolution used for shader node previews, which are displayed above the nodes.
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Miscellaneous

Sculpt Overlay Color

This color button allows the user to define a color
to be used in the inner part of the brushes circle
when in sculpt mode, and it is placed as an
overlay to the brush, representing the focal point
of the brush influence. 

The overlay color is visible only when the overlay
visibility is selected (clicking at the eye to set its
visibility), and the transparency of the overlay is
controlled by the alpha slider located at the brush
pop-up, located at the top of the tool shelf, when
in sculpt mode.

Animation

Contains the settings for the animation
editors. 
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Timeline

Allow negative Frames

Minimum Grid Spacing 

Adjust the minimum number of pixels
between grid lines in a 2D  viewport. This
affects for example Timeline, Dope sheet,
Graph or NLE Editor.

Time Code Style

In Timeline, Dope sheet, Graph
and NLE editor you can either
display the keyframe number
or the time in the timeline.
Define how the time gets
displayed when you have
chosen to display time.

Zoom To Frame Type 

Timeline, Dope sheet, Graph and NLE. Define how zooming to frame focuses around
current frame.

Keyframes

Default Key channels

Define which channels are recorded by default In case no
keyingset is defined.

Visual Keying 

When an object is using constraints, the objects property
value doesn't actually change. Visual Keying will add
keyframes to the object property, with a value based on the visual transformation from the constraint. 

Only Insert Needed 

This will only insert keyframes if the value of the property is different. 

If there is a keyframe on the current frame, and it has no changes, it will skip recording over the keyframe.

If there is no keyframe, and it has no changes, skip recording the keyframe.
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Auto Keyframing

Show Warning 

Displays a warning at the top right of the 3D View, when moving objects, if Auto Keyframe is on. 

Only Insert Available 

This will only add keyframes to channel F-Curves that already exist. 

Enable in new scenes

Automatic keyframe insertion for objects and bones as Default setting for new scenes.

F-Curves

Unselected Opacity

The amount that unselected F-curves stands out from the background in the Graph Editor.

Default Smoothing Mode

Auto handle smoothing mode for new added curves. None or Continuous accelleration.

Default Interpolation 

This controls how the state between two keyframes is
computed. Default interpolation for new keyframes is
Bezier which provides smooth acceleration and de-
acceleration whereas Linear or Constant is more abrupt. 

Default Handles

The default handle types for F-Curves.

XYZ to RGB 

Color for X, Y or Z animation curves (location, scale or rotation) are the same as the color for the X, Y and Z 
axis. 
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Channel Group Colors

Use animation channel group colors. Uses the bone group colors.

Only Show Selected F-Curve Keyframes

Just show the keyframes from the selected curves only. 

F-Curve High Quality Drawing

Display the curves in highest quality.

Addons

An add-on is external software written by other
developers. Add-ons are a way to extend the core
functionality of Bforartists. Bforartists already comes
with lots of add-ons. Some already activated. Here you
can manage them, and add even more add-ons if required.

Note that Bforartists works with Blender addons. 

Note also that this list contains some add-ons that are 
required by Bforartists to work proper. You will see a 
warning in those addons. Don't turn them off. Or vital
parts of Bforartists will not longer work. Like the 
toolbar.

Header

Official / Community / Testing

Filter the addons by supported level.

The addons comes in three flavors. The official addons are the addons from the Blender developers. 
Community are the addons from Community developers that doesn't officially belong to the Blender developer 
team. And Testing add-ons are add-ons that aren't really finished yet. They can do the job, but are experimental.

Install Add-on

Install external add-ons. Note that addons that comes as a zip file should be loaded zipped. And not unzipped.
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Refresh

Scan the add-on directories for new modules. This is useful when you decide to install an add-on manually.

Category

Refine the search down to single categories.

Search

Search for keywords.

List of Addons

This is the list of installed add-ons. Installed does not
necessarily mean that they are enabled. To enable an add-
on, tick the checkbox at the left. When you expand an add-
on then you will find some further informations.
Sometimes you will also find some more settings.

Input

This tab contains some input related settings. 

Keyboard

Emulate Numpad

Laptops usually doesn't have Numpad keys. Choose to use the number keys above the letters as Numpad keys.

Default to advanced numeric input

When entering numbers while transforming default to advanced mode for full math expression evaluation.
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Mouse

Emulate 3 Button Mouse 

In the Windows world 3 button mouses are common. But
Apple for example has a single mouse button. Bforartists
can emulate a 3 button mouse. The third mouse button
will then be emulated by a key combination.

3-button Mouse 2-button Mouse Apple Mouse

LMB LMB LMB (mouse button)

MMB Alt-LMB Alt-LMB (Option/Alt key + 

mouse button)

RMB RMB Cmd-LMB (Command/Apple key 

+ mouse button)

Mouse/Keyboard combinations referenced in this manual can be expressed with the combinations shown in the 
table. For example, MMB drag becomes Alt-LMB drag. Shift-Alt-RMB becomes Shift-Alt-Cmd-LMB 

on a single-button mouse. 

Tablet
This panel contains some tablet related settings.

Tablet API

Choose which API Bforartists should choose for the pressure sensitivity of your tablet.

Max Threshold

The raw input pressure value which is interpreted as 100 % by Bforartists.

Softness

Adjust the pressure softness of the low pressure response onset using a gamma curve.

Touchpad

Multi Touch Gestures

Use multi touch gestures for navigation with touchpad instead of scroll wheel emulation.
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NDOF
You can use a 3D mouse in Bforartists. Here you find
some 3D mouse related settings.

Pan Sensitivity

Adjust the pan sensitivity.

Orbit Sensitivity

Adjust the orbit sensitivity

Deadzone

The initial movement that is needed before the
movement gets recognized.

Navigation

Choose the navigation style between Free and Orbit.

Rotation

Adjust in what style you rotate the 3D View. Turntable and Trackball navigation reacts a bit different. Turntable
navigation tries to hold the horizon line while rotation. Turntable rotation rotates also the horizon line.

Show Navigation Guide

Display the axis and center during rotation.

Invert Zoom

Zoom using opposite direction.

Lock Camera Pan/Zoom

Pan / Zoom the camera view instead of leaving the camera view when orbitting.

Pan Swap Y and X Axes

Pan uses up - down instead of  forward - backward

Invert Axis Pan

The invert axis for panning. Inactive axis are not inverted.

Orbit

The axis to orbit around when panning.

32



Bforartists 4 Reference Manual - 30 Editors - Preferences

Fly / Walk 

Lock Horizon

Keep horizon level while flying with 3D mouse.

Helicopter Mode

Using up/down directly controls the Z position in the 3D viewport.

Navigation

The navigation section contains the settings for navigating in
the 3D view.

Orbit & Pan

Orbit Method

Adjust in what style you rotate the 3D View. Turntable and
Trackball navigation reacts a bit different. Turntable
navigation tries to hold the horizon line while rotation.
Turntable rotation rotates also the horizon line.

Orbit around selection

The selected object becomes the rotation center of the viewport. When there is no selection the point of the last 
selection will be used.

Auto Perspective 

With Auto perspective off when you switch to one of the side views, then the chosen orthographic or 
perspectivic view is kept. Means when you have the distorted perspectivic view, and switch to top view, then 
your mesh will be perspectivic distorted here too.

With Auto Perspective the view in the side views will be orthographic, and not perspectivic, no matter what 
View Persp/Ortho is chosen.

Auto Depth 

Use the depth under the mouse to improve view pan, rotate, zoom functionality. 

Smooth View 

The switch to change to another view is animated. Adjust the length of time the animation takes when changing 
the view with the Numpad (Top/Side/Front/Camera...). A value of zero will remove the animation, and 
immediately switch to the chosen view. 
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Rotation Angle 

Rotation step size in degrees, when Numpad4, Numpad6, Numpad8, or Numpad2 are used to rotate the 3D 

View. 

Zoom

Zoom Method

Adjust the zoom style.

Continue 

The Continue zooming option allows you to control the speed (and not the value) of zooming by moving away 
from the initial click point. Moving up from the initial click-point or to the right will zoom out, moving down or
to the left will zoom in. The further away you move, the faster the zoom movement will be. 

Dolly 

Dolly zooming works similarly to Continue zooming except that zoom speed is constant. 

Scale 

Scale zooming depends on where you first click in the view. 

Zoom Axis

With Vertical moving up zooms out and moving down zooms in. With Horizontal moving left
zooms in and moving right zooms out. 

Invert Mouse Zoom Direction 

Inverts the Zoom direction for Dolly and Continue zooming. 

Invert Wheel Zoom Direction 

Inverts the direction of the mouse wheel zoom. 

Zoom to Mouse Position 

When enabled, the mouse pointer position becomes the focus point of zooming instead of the 2D window 
center.

Fly & Walk
Fly and walk are special navigation modes. They can be
found in the Navi menu. The Fly & walk section also
contains some settings from the View navigation style,
since this style uses elements from walk and fly navigation too

34



Bforartists 4 Reference Manual - 30 Editors - Preferences

View Navigation

Adjust how the View navigation in the 3D view behaves. You can choose
between walk and fly.

Walk

Reverse Mouse

Reverse the mouse movement when you move upwards or
downwards

Mouse Sensitivity

Adjust how strong the viewport movement reacts to the mouse movement

Teleport Duration

Adjust the teleport duration when teleporting in navigation mode.

Walk Speed

Adjust the walk speed

Speed Factor

Adjust the run speed.

Gravity

Choose if the virtual character, your point of view, uses gravity.

View Height

Adjust the height of the point of view for your virtual character. This setting requires to have Gravity on.

Jump Height

Adjust the maximal jump height for your virtual character. This setting requires to have Gravity on.

Fly

Fly has no further settings.
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Keymap
The key map allows you to customize how Bforartists
reacts to  mouse and keyboard, and change key map
entries. All Input behavior is defined in the key map.

Header

Key Configs

A drop down menu to choose existing key maps. The + button at the right adds a
new key map. The current configuration will then be saved as a new key map.

Import

Import an external key map. This opens up a file selector to choose the
python file.

Export

Export a key configuration python file from Bforartists.

Filter Type

Define if you want to search for a tool name or for a hotkey. By tool name, or by the hotkey name

Search Field

Enter a search string.

Key map Editor
The Key map editor is the list where the single inputs are
defined. Every input can have several specific operator
settings in the lower area. The upper area defines the general
things like the key combos. The lower area those operator
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specific settings.

Normally you don't edit those key entries manually. Most of the usual tools have an
entry in the right click menu to create or to change the hotkey. But sometimes you have
to do this task manually.

Map Type

Here you define what input will control the function.

Type of Event

Here you define your main hotkey. In our case the right mouse.

Operator

The Python operator name for the tool. 

Type of Event

The main hotkey again. For special events like mouse events you have a
drop down box here.

Value

What key action is required. On click, on double click, etc. ...

Secondary hotkeys

Many hotkeys uses a key combination, for example Shift D for select.
Define those secondary hotkeys.
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Specific settings

Every operator can have several settings. And some
tools even just defines itself by those different
settings. Here you can see two different zoom view
operators. They just differ in the Delta value.

What is equal in the key map in all cases is the RNA
entry. That's the name of the operator again. But this
time not the Python code operator name. But the C
code operator name.

Restore 

When you modify a key map item, then you will see a Restore button appear
at the right side. This indicates that this key map item got modified. A click
at the Restore button will restore the original hotkey.

System
The system tab contains system relevant
settings. Such as Cuda for Cycles renderer
or OpenCL or Memory related settings.

Cycles Render Devices
The Options here will set the compute device used by the Cycles render engine.

None 

When set to None or the only option is None: your CPU will be used as a computing device for Cycles Render 
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Engine.

CUDA 

If the system has a compatible Nvidia CUDA enabled graphics card you will be able to use it to render with the 
Cycles render engine. 

OptiX

Optix is a raytracing framework from Nvidia that runs on the GPU. 

HIP

If the system has a compatible HIP device, it will show up has an option for rendering cycles. 

oneAPI

If the system has a compatible oneAPI device, it will show up has an option for rendering cycles. 

Operating System Settings
Windows only.

Register or unregister to connect the blend file with this
Bforartists version. 

For all Users

Register the file association for all users, or just for the current user.

Make default

Associates the .blend file with this installation of Bforartists. This means that double clicking at a .blend file 
will now open this file with the currently open Bforartists installation. This is useful when you work with 
different versions of Bforartists, and want to open the files with an older or newer version.

Memory and Limits

Undo Steps

Number of Undo steps available. 

Undo Memory Limit 

Maximum memory usage in Mb (0 is unlimited).

Global Undo 

Bforartists Undo system is split in several subpart. Global undo stores the undo step outside of Edit mode. For 
example for duplicating Objects, changing panel settings or switching between modes.
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Console Scrollback Lines

Maximum number of lines to store for the console buffer.

Texture Time Out 

Time since last access of a GL texture in seconds, after which it is freed. Set to 0 to keep textures allocated. 
Minimum: 0, Maximum: 3600. 

Garbage Collection Rate 

Number of seconds between each run of the GL texture garbage collector. Minimum: 0, Maximum: 3600. 

VBO Time Out

Time since last access of a GL Vertex buffer object, in short VBO, in seconds after which it is freed. Set to 0 to 
keep VBO allocated.

Garbage Collection Rate 

Number of seconds between each run of the GL vertex buffer garbage collector. Minimum: 0, Maximum: 3600. 

Video Sequencer

Memory Cache Limit

Upper limit of the sequence's memory cache (megabytes).
For optimum clip editor and sequencer performance, high
values are recommended. 

Use Disk Cache

Store cached images to disk.

Directory

The disk cache directory.

Cache Limit

The disk cache limit in gigabytes.

Compression

What compression method to use. Note that compression saves space, but costs
performance.

Proxy Setup

Proxies are preview objects, reduced in size to make a smooth working possible. Images
for example.
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Automatic 

Automatically create proxies for each image material. 

Manual

You have to create the proxies by hand.

Sound

Audio Device 

Set the audio device.

OpenAL 

Provides buffered sound rendering with 3D/spatial support. 

OpenAL - OpenAL Soft

Provides buffered sound rendering with 3D/spatial support. 

SDL 

Uses Simple Direct Media Layer API from libsdl.org to render sounds directly to the sound device output.

Null

No Audio support. No audio output, but audio strips can be loaded normally.

Channels 

Set the audio channel count. Available options are: Mono, Stereo, 4 Channels , 5.1
Surround , 7.1 Surround

Mixing Buffer 

Set the number of samples used by the audio mixing buffer. Available options are: 512 , 
1024 , 2048, 4096 , 8192, 16384, and 32768 
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Sample Rate 

Set the audio sample rate. Available options are: 44.1 Khz, 48 Khs, 96 Khz and 192Khz 

Sample Format 

Set the audio sample format. Available options are: 32 bit float, 8 bit Unsigned, 16 Bits
Signed, 24 Bits Signed, 32 Bits Signed, 32 Bits Float, and 64 Bits Float. 

Save & Load

Blend Files
Blend file related settings. What happens at load, what
happens at save ...

Relative Paths 

By default, external files use a relative path.

Compress File 

Compress blend-file when saving.

The option to Compress files will compact your files
whenever Blender is saving them. Dense meshes, large
packed textures or lots of elements in your scene will result in a large blend being created.

This option may slow down Blender when you quit, or
under normal operation when Blender is saving your
backup files. Using this option traces processor time for
file-size.

Load UI 

In Bforartists you can load the scene in the screen layout
in which you have saved it. Default is off.

This can also be changed individually when loading a file
from the Open blend-file panel of the File Browser. 
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File Preview

None

When this option is off, previews of images and materials in the File Browser are created on
demand. 

Auto

Automatically create previews of images and materials in the File Browser. The best preview type is chosen 
automatically.

Screenshot

Capture the entire window to create previews of images and materials in the File Browser.

Camera Preview

Use a workbench render to create the previews of images and materials in the File Browser.

Tabs as Spaces

For text files, automatically convert tabs into spaces when loading a blend file that contains a text file. Correct 
indentation is relevant for python scripts.

Save Prompt

Ask for confirmation when quitting with unsaved changes.

Save Versions

Number of versions created for the same file (for backup).

This option tells Bforartists to keep the indicated number of saved versions of your file in your current working 
directory when you manually save a file. These files will have the extension: .blend1, .blend2, etc., with 

the number increasing to the number of versions you specify. Older files will be named with a higher number. 
e.g. With the default setting of 2, you will have three versions of your file: *.blend (your last save), 

*.blend1 (your second last save) and *.blend2 (your third last save).

Recent Files

The number of recent files to display in the Recent panel.

Auto Save

Auto Save Temporary File 

Enable Auto Save. Auto save creates a temporary file.

Checking this box tells Blender to automatically save a backup copy of your work-in-progress to the Temp 
directory (refer to the File tab in the Preferences for its location).

The Auto Saved files are named using a random number and have a blend extension.
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Timer 

Adjust the number of minutes between each Auto Save. The minimum is 1, and the Maximum is 60 (Save at 
every one hour).

Auto Run Python Scripts

Run the python scripts at loading a blend file that includes these scripts.

Excluded paths

Define file paths where loaded blend files should not run the included scripts even when auto run python scripts
is ticked.

File Browser
File browser related settings.

Filter Files 

By activating this, the file dialog in the File Browser will only show appropriate files in the Load dialog. Blend 
files for example.

The selection of file types can also be changed in the header of the file dialog. 

Show Hidden File/Data

On non Windows systems like Linux and Mac OS X files are hidden by a dot in front of the file name. Here you
can make them visible in the file browser if you want. Note that this feature does not work with Windows.

Show Recent Locations 

Hides the Recent panel of the File Browser which displays recently accessed
folders. 

Show System Bookmarks

Hides the System Bookmarks panel of the File Browser which displays the system
bookmarks. 
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File Paths
Contains everything file path related. 

Data

Fonts 

Default location when searching for font files. 

Textures 

Default location when searching for image textures. 

Sounds 

Default location when searching for sound files.

Temporary Files

The location where temporary files are stored. 

Script Directories
An additional location to search for Python scripts.

By default Bforartists looks in several directories (OS
dependent) for scripts. Here you can add another directory
to check for scripts. This can be used to store certain
scripts/templates/presets independently of the currently
used Blender Version.

Inside the specified folder specific folders have to be created to tell Bforartists what to look for where. This 
folder structure has to mirror the structure of the scripts folder found in the installation directory of :

• scripts 
• add-ons 
• modules 
• presets 
• camera 
• cloth 
• interface_theme 
• operator 
• render 
• ... 
• startup 
• templates

Not all of the folders have to be present. 
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Python scripts (including driver expressions) are not executed by default for security reasons.

Render

Render Output 

Where rendered images/videos are saved. 

Render Cache 

The location where cached render images are stored. 

Applications

Image Editor 

The path to an external image editing software to use for
image editing. Photoshop, Gimp, etc.

Animation Player 

By default Bforartists uses the internal player to play back animations. Choose an external program to use for 
playback of rendered animations. There are also some presets available.

Text Editor

Here you can define an external text editor. Which allows you to edit text files externally.
Which then can be done from the File menu in the text editor.

Program

Enter the path to the external text editor.

Arguments

Enter at least a filepath argument so that the
code can be opened by the external editor.
More arguments can be found in the tooltip.

Development

I18n Branches 

The path to the /branches directory in your local repository translation copy. This allows translating the UI. 

See interface tab, the translation panel.
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Asset Libraries
The default paths for custom asset libraries. The
functionality should be self explaining. 

To change the path simply type in a path, or use the path
picker at the end.

To add a new path to an asset library click at the + button
below the list. 

To remove a path click at the X button at the end.

Asset List

The list of available asset libraries.

Add

Add a new asset library to the asset list.

Remove

Remove the selected library from the asset list.

Path

The path to the current selected asset library.

Import Method

How to import the assets from the asset library into the scene.

Append (Reuse Data)

Imports the assets as a copied data. The data is fully imported, and not linked to the asset library. This method 
reuses existing materials or meshes.

Append

Imports the assets as a copied data. The data is fully imported, and not linked to the asset library. This method 
also imports every material and mesh from scratch, and can create duplicated redundant data.

Link

Links the assets to the assets in the asset library. The data is linked to the asset library. When you remove the 
asset library then the linked data is also removed.

Relative Path

Use relative paths when linking from this librar
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Experimental

Here you may find some experimental settings from the
Blender development. We will not cover them here. They
change very quick. Use at own risk!
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